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VISION 
 

To become a Centre of excellence for Education and Research in 

Mechanical Engineering. 
 

 
 

MISSION 

 Attaining academic excellence through effective teaching learning process 

and state of the art infrastructure. 
 

 Providing research culture through academic and applied research. 
 

 Inculcating social consciousness and ethical values through co-curricular 

and extra-curricular activities. 
 

 

 

 

PROGRAM EDUCATIONAL OBJECTIVES (PEOs) 
 

PEO I 
Graduates will have successful career in Mechanical Engineering 

and service industries.  

PEO II 
Graduates will contribute towards technological development 

through academic research and industrial practices.  

PEO III 
Graduates will practice their profession with good communication, 

leadership, ethics and social responsibility.  

PEO IV 
Graduates will adapt to evolving technologies through lifelong 

learning.  
 [ 

 

 

PROGRAM SPECIFIC OUTCOMES (PSOs) 

PSO1 

Derive technical knowledge and skills in the design, develop, analyze 

and manufacture of mechanical systems with sustainable energy, by 

the use of modern tools and techniques and applying research based 

knowledge. 

PSO 2 

Acquire technical competency to face continuous technological 

changes in the field of mechanical engineering and provide creative, 

innovative and sustainable solutions to complex engineering 

problems. 

PSO 3 
Attain academic and professional skills for successful career and to 

serve the society needs in local and global environment. 
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GENERAL INSTRUCTIONS FOR LABORATORY CLASSES 

 Students must attend the lab classes with ID cards. 

 Boy should “TUCK IN” the shirts. 

 Students should wear uniform only. 

 LONG HAIR should be protected. 

 Any other website should not be operated other than the prescribed one for that day. 

 POWER SUPPLY to your test table should be obtained only through the LAB 

TECHNICIAN. 

 Any damage to any of the equipment/instrument/machine caused due to carelessness, 

the cost will be fully recovered from the individual (or) group of students. 
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20ME6L1 
COMPUTER AIDED SIMULATION AND ANALYSIS 

LABORATORY L T P C 
  0 0 3 1.5 

OBJECTIVES: 
    

 To understand the applications of various software tools for analysis  

 To understand geometric modeling in analysis software. 

  To find the stress and other related parameters of bars, beams loaded with loading 

conditions. 

 To derive the output from the analysis software. 

 To solve real time problems using these tools..  
 

PREREQUISITE: 

Course Code: 20ME301, 20ME304, 20ME502 

Course Name: Strength of Materials, Thermal engineering, Dynamics of Machinery 

 

LIST OF EXPERIMENTS 

1. 1D application problems like composite walls/beams 

2. 2D application problems like flat plates, simple shells, cylinder 

3. Stress analysis of axi – symmetric components. 

4. Modal analysis (Beams). 

5. 3D modeling of pulley. 

6. 3D analysis of rotating shaft. 

7. Nonlinear analysis using contact elements. 

8. Thermo mechanical analysis of plate. 

9. Transient analysis of Fin. 

TOTAL: 45PERIODS 

 

LIST OF EQUIPMENT FOR A BATCH OF 30 STUDENTS 
 

S. NO. NAME OF THE EQUIPMENT Qty. 

1. Computer work station 30 

2.  Printer 1 

3. Ansys Software 30 licenses 
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Cycle A - Simulation 

Ex No : 1                          Date : 

MATLAB basics, Dealing with matrices, Graphing-Functions of one variable 
and two variables 

 

 

 

 

 

 

 

Aim: To the basics of MATLB dealing with matrices and to draw graph of one variable and 

two variables using MATLAB software. 

Basic MATLAB Programming and matrix operations. 

 MATLAB is a matrix-based language. Since operations may be performed on each entry 

of a matrix, “for” loops can often be by passed by using this option. As a consequence, 

MATLAB programs are often much shorter and easier to read than programs written for 

instance in C or Fortran. Below, we mention basic MATLAB commands, which will allow a 

novice to start using this software.  

1. Defining a row matrix and performing operations on it. Assume that you want to evaluate 

the function f(x) = x
3
 – 6x

2 
+ 3 at different values of x. This can be accomplished with 

two lines of MATLAB code. 

%Define the values of x 

X= 0:0.1:1; 

%Evaluate f 

f = x.^3 – 6*x.^2 + 3; 

In this example, x varies between o and 1 in steps of 0.01. Comments are preceded by 

a % sign. The symbols ^ and * stands for the power and multiplication operators respectively. 

The dot in front of ^n indicates that each entry of the row matrix x is raised to the power n. In 

the absence of this dot, MATLAB would try to take the nth power of x, and an error message 

would be produced since x is not a square matrix. A semicolon at the end of a command line 

indicates that the output should not be printed on the screen. 

Exercises: 

1. Type size (x) to find out what the size of x is 

2. Evaluate the cosine and sine of x 

3. Define a square matrix 
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A = (1 2  3 4 ) by typing A = [ 1 2; 3 4 ]. Then compute the square of A (type A^2) and 

compare the result to that obtained by typing A.^2. 

1. Define matrix A and B with any size and perform the value of A+B, A-B, A*B, A/B, 

A^2*B, A*A 

2. Verify A*B is not equal to B*A 

3. A*inv(A)= identity Matrix 

 

2. Plotting the graph of a function of one variable 

The command plot(x,f) plots f as a function of x. The figure can be edited by hand to 

add labels, change the thickness of the line of the plot, add markers, change the axes etc. All 

of these attributes can also be specified as part of the plot command. 

Exercises: 

1. Plot (x, sin(x)) 

2. Plot (x, cos(x)) 

3. plot(x,sin(x),'-b',x,cos(x),'--r') 

4. Plot the graph of exp(x) for x =(-5,10) 
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3. Plotting the graph of a function of two variables 

Assume that we want to use MATLAB to plot the graph of f(x,y) = x
2
 – 3y

2 

for x =-3:0.01:3 

for y = -5:0.01:5 

We first need to define a numerical grid where the function f will be evaluated. To this end, 

define the matrices x and y, 

(x,y) = meshgrid(x,y) 

Then, evaluate f at the points on the grid and put the result in a matrix Z 

Z= x.^2-3*y.^2; 

Finally, plot the graph of f with the following command surf (x,y,z), shading interp. The 

surface can be rotated by typing rotate 3D, or by clicking on the rotation icon on the figure. 

Plot (x,z) 
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Exercises 

1. Plot the graph of f(x) = exp(-2x
2
-3y

2
). Choose appropriate intervals for x and y. 

2. Plot the graph of f(x) = cos(x) sin(y). Choose appropriate intervals for x and y. 

3. Change the color map of one of the plots above by using the commands color map bone 

or colormap jet or colormap cool. 

Matlab Program for Surface  

x=-3:0.25:3; 

y=-5:0.25:5; 

[x,y] = meshgrid(x,y); 

z=x.^2-(3*y.^2); 

surf(x,y,z) 

xlabel('x'); ylabel('y') 

zlabel('z') 

 
 

 

Result: 

Thus the basics of MATLAB dealing with matrices are studied and the graph for one 

variable and two variables are drawn using MATLAB software. 

 

*********************** 
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Ex No : 2                         Date : 

Use of MATLAB to solve simple problems in vibration 

 

 

 

 

 

 

 

Problem Definition 

Spring Mass Damper System – Unforced Response  

 

Solve for five cycles, the response of an unforced system given by the equation 
       ..               . 

m x+ c x+ kx = (1) 

For c =2 ; m = 1 kg; k = 100 N/m; x (0) = 10 m;   .x(0) = -8; 

 

Aim:  

To find the natural vibration of spring mass system using MATLAB software. 

 

Solution 

 

X(t) = A e
- Wn t 

sin (Wd t+) 

A=(1/wd)*(sqrt(((vo+zeta*wn*xo)^2)+((xo*wd)^2))) 

 = arctan((xo*wd)/(vo+zeta*wn*xo)) 

=c/(2*m*wn) 

Natural frequency wn=sqrt(k/m)  

Mat Lab Program 

m=1; 

k=100;  

c=2;  

vo=1/1000;  

xo=1/1000;  

t=linspace(0,4,100);  

wn=sqrt(k/m);  

zeta=c/(2*m*wn); 

wd=wn*sqrt(1-zeta^2);  

A=(1/wd)*(sqrt(((vo+zeta*wn*xo)^2)+((xo*wd)^2)));  

ang=atan((xo*wd)/(vo+zeta*wn*xo));  

xt=A*sin(t*wd+ang).*exp(-zeta*t*wn);  

display(c)  

plot(t,xt)  
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grid on     

ylabel('x(t)') 

xlabel ('t') 

 

 

 

 

Result: 

Thus the natural vibration of spring mass system is obtained using MATLAB 

software. 
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Ex No : 3                         Date : 

Mechanism Simulation using Multibody Dynamic software  

 

 

 

 

 

 

 

 

Problem Definition: 

Assemble the given components of Geneva drive mechanism and simulate using 

multibody dynamic software. 

                                 

Aim: To assemble the given components and simulate the Geneva drive mechanism using 

Creo 3.0 software. 
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ALL DIMENSIONS ARE IN MM 

Procedure: 

1. Assemble the given components using user defined mating condition. 

2. Attach the servo motor and give the velocity. 

3. Go to the mechanism analysis and give the start time and end time. 

4. Run the given mechanism. 

5. Save the analysis definition file. 

 

Result: 

Thus the simulation of Geneva mechanism is done using Creo 3.0 software. 
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Cycle B - Analysis 

Ex No : 1                         Date : 

INTRODUCTION to FEA and ANSYS 

 

 

What is FEA? 

1. Finite Element analysis is a way to simulate loading conditions on a design and 

determine the design response to those conditions.  

2. The design is modeled using discrete building blocks called elements. 

3. Each element has exact equations that describe how it responds to a certain load. 

4. The “Sum” of the response of all elements in the model gives the total response of the 

design. 

5. The elements have a finite number of unknowns, hence the name finite elements. 

6. The finite element model, which has a finite number of unknowns, can only 

approximate the response of the physical system which has infinite unknowns. 

 

How good is the approximation? 
 

Unfortunately, there is no easy answer to this question, it depends entirely on what 

you are simulating and the tools you use for the simulation. 

Why is FEA needed? 

1. To reduce the amount of prototype testing. 

2. Computer Simulation allows multiple “what if“scenarios to be tested quickly and 

effectively. 

3. To simulate designs those are not suitable for prototype testing. E.g. Surgical Implants 

such as an artificial knee. 

About ANSYS: 

• ANSYS is a complete FEA software package used by engineers worldwide in virtually 

all fields of engineering. ANSYS is a virtual Prototyping technique used to iterate 

various scenarios to optimize the product. 

General Procedure of Finite Element Analysis: 

1. Creation of geometry or continuum using preprocessor. 

2. Discretization of geometry or continuum using preprocessor. 

3. Checking for convergence of elements and nodes using preprocessor. 

4. Applying loads and boundary conditions using preprocessor. 

5. Solving or analyzing using solver 

6. Viewing of Results using postprocessor. 
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Build Geometry: 

Construct a two (or) three dimensional representation of the object to be modeled and 

tested using the work plane co-ordinate system in Ansys. 

Define Material Properties: 

Define the necessary material from the library that composes the object model which 

includes thermal and mechanical properties. 

Generate Mesh: 

Now define how the model system should be broken down into finite pieces. 

Apply Loads: 

• The last task in preprocessing is to restrict the system by constraining the displacement 

and physical loading. 

Obtain Solution: 

• The solution is obtained using solver available in ANSYS. The computer can 

understand easily if the problem is solved in matrices.  

Present the Result: 

• After the solution has been obtained there are many ways to present Ansys result either 

in graph or in plot. 

Specific Capabilities of ANSYS Structural Analysis: 

• Structural analysis is probably the most the common application of the finite element 

method such as piston, machine parts and tools. 

Static Analysis: 

• It is the used to determine displacement, stress etc. under static loading conditions. 

Ansys can compute linear and non-linear types (e.g. the large strain hyper elasticity 

and creep problems). 

Transient Dynamic Analysis: 

• It is used to determine the response of a structure to time varying loads. 
 

Buckling Analysis: 

• It is used to calculate buckling load and to determine the shape of the component after 

applying the buckling load. Both linear buckling and non – linear buckling analysis 

are possible. 
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Thermal Analysis: 

The steady state analysis of any solid under thermal boundary conditions calculates 

the effect of steady thermal load on a system (or) component that includes the following. 

a) Convection. 

b) Radiation. 

c) Heat flow rates. 

d) Heat fluxes. 

e) Heat generation rates. 

f) Constant temperature boundaries. 

Fluid Flow: 

• The ANSYS CFD offers comprehensive tools for analysis of two-dimensional and 

three dimensional fluid flow fields.  

Magnetic: 

• Magnetic analysis is done using Ansys / Electromagnetic program. It can calculate the 

magnetic field in device such as power generators, electric motor etc. Interest in 

magnetic analysis is finding magnetic flux, magnetic density, power loss and 

magnetic forces. 
 

Acoustic / Vibrations: 

• Ansys is the capable of modeling and analyzing vibration system. Acoustic is the study 

of the generation, absorption and reflection of pressure waves in a fluid application.  

• Few examples of acoustic applications are  

a) Design of concert house, where an even distribution of sound 

pressure is possible. 

b) Noise cancellation in automobile.  

c) Underground water acoustics. 

d) Noise minimization in machine shop. 

e) Geophysical exploration. 

Coupled Fields: 

• A coupled field analysis is an analysis that takes into account the interation between 

two (or) more fields of engineering analysis. Pressure vessels, Induction heating and 

Micro electro mechanical systems are few examples. 

Result:  

Thus the basics of FEA and ANSYS are studied. 

********************** 
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Ex No : 2 

Force and stress analysis using Link elements in Trusses 

 

 

 

 

 

 

 

Problem Specification: 

Find the reaction forces, axial forces and stresses at each node for the following truss. Also find the 

deflection at each node. 

Cross-sectional area of truss members = 3.0E-4 m2
;  

Modulus of Elasticity = 2.07E11 N/m2.  

Circled numbers shown are node numbers. 

Poisson’s ratio = 0.3 

 

Aim:  

To find the reaction forces, axial forces and stresses at each node for the given truss and  also 

find the deflection at each node  using ANSYS software 

Procedure: 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Link   →  2D spar   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 3.0e-4 →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 2.07E11  →  Prxy : 0.3   →  Ok 

b. Materials   →  Exit    

F= 125 N F= 100 N

3 m 3 m 3 m 3 m

3 m

1 2 3 4 5

6 7 8
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5. Modeling 

a. Modeling  →  Create  →  nodes  →  In active CS  →  Enter point. 

b. 1  →  0,0 2  →  3,0   3  →  6,0   4  →  9,0   5  →  12,0  6  →  3,3   7  →  6,3   8  

→  9,3 

c. Create  →  Elements  →  through auto numbered  →  Select nodes for element  →  

1  →  1,2      2  →  2,3     3  →  3,4     4  →  4,5       5  →  1,6       6  →  2,6     7  

→  3,6  8  →  3,7       9  →  3,8     10  →  4,8     11  →  5,8       12  →  6,7    13  →  

7,8   → Click OK. 

 

7. Solution 

a. Solution  →  Define Loads  →  Apply  →  Structural  →  Displacement  →  on nodes  

→  Select node Point 5  →  Click OK →  Select All DOF Constrained. Select node 

Point 1  →  Select (FY) → enter the value =0  Click OK  

 

b. Force/ moment →on nodes →  Select node point 2   →   Select (FY)  →  Enter Value 

of -125  →  Click OK →  Select node point 3   →   Select (FY)  →  Enter Value of -

100  →  Click OK 

c. Solution  →  Solve  →  Current LS  →  OK. 
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8. General Post proc 

a. General Post proc  →  Plot Results  →  Deformed Shape  →  Def+Undeformed  →  

OK. 

b. UtilityMenu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

c.  List result → Reaction solution →  ok→  save to file. 

d. sList result → Element solution →  ok  →  save to file. 

e. General Postproc -> List Results -> Nodal Solution -> DOF Solution -> ALL DOFs →  

save to file. 

 

Inference:  

Analysis of truss is used mainly in civil engineering (Eg: Roof structures) 

Result: 

Thus the reaction forces, axial forces and stresses at each node for the given truss and  also 

the deflection at each node is found  using ANSYS software 
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Ex No 3(a)                          Date : 

Stress Analysis of Cantilever Beam 

  

 

 

 

 

 

 

 

Problem Specification: 

 
 

   E = 2.1e5 N/mm
2
   γ = 0.3    Izz =  833.33 mm

4 

   L  = 100mm     a = 10mm   b  =  10mm  

   F = 100 N 

Aim:  

To find deformed shape, shear force diagram and bending moment diagram for the 

Cantilever beam using ANSYS software 

Procedure: 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 100, Izz = 833.33 , Height = 10  →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 2.1e5  →  Prxy : 0.3   →  Ok 

b. Materials   →  Exit    

5. Modeling 

a. Modeling  →  Create  →  Key points  →  In active CS  →  Enter Key point. 

b. 1  →  0,0,0  2  →  100,0,0 

c. Lines  →  Lines  →  Straight Lines  →  Select Key point 1&2  →  Click OK. 
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Deformed shape 

 
Shear forces Diagram 

 

Bending Moment Diagram 
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6. Meshing 

a. Mesh Tool  →  Size control → Global → Size  →  Enter No. of Division = 25  →  OK. 

b. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

c. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (ON)  →  

OK 

d. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (OFF)  

→  OK 

7. Solution 

a. Solution  →  Define Loads  →  Apply  →  Structural  →  Displacement  →  on Key 

Points  →  Select key Points 1  →  Click OK →  Select All DOF Constrained. 

b. Force/ moment  →  Select key point 2   →   Select (FY)  →  Enter Value of -100  →  

Click OK. 

c. Solution  →  Solve  →  Current LS  →  OK. 

8. General Post proc 

a. General Post proc  →  Plot Results  →  Deformed Shape  →  Def+Undeformed  →  

OK. 

b. UtilityMenu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

c. Element Table  →  Define Table  →  Add  →  Select By Sequence  → SM1SC,2  → 

apply,  

d. Select By Sequence  → SM1SC,6  →  apply 

e. Select By Sequence  → SM1SC,8  →  apply 

f.     Select By Sequence  → SM1SC,12  →  apply  →  OK. 

9. Plot Result 

a. Plot Result  →  Contour Plot  → Line Element Resolution  →   

b. Select SMISC2 + SMISC8 for S.F.D.  →  OK 

c. UtilityMenu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

d. Select SMISC6 + SMISC12 for B.M.D.  →  OK 

e. UtilityMenu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

Inference:  

Analysis of beam is used mainly in civil engineering (Eg: Bridges, Roof structures) 

Result: 

Thus the deformed shape , shear force diagram and Bending moment diagram are 

obtained for the Cantilever Beam using ANSYS software. 

******************** 
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Ex No :3(b)                          Date : 

Stress Analysis of Simply Supported Beam with UDL 

 

 

 

 

 

 

Problem Specification: 
 

 

 
E  =  2.1e11 N/m

2
   =  0.3   Izz  =  0.083333m

4 

L  = 12m     a  =  1m   b   =  1m   
 

Aim:  

To find deformed shape, shear force diagram and bending moment diagram for the 

simply supported beam with UDL using ANSYS software 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 1 ,Izz = 0.083333 , Height = 1  →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 2.1e11  →  Prxy : 0.3   →  Ok  Materials   →  

Exit    

5. Modeling 

a. Modeling  →  Create  →  Key points  →  In active CS  →  Select Key point. 

b. 1  →  0,0,0  2  →  12,0,0 

c. Lines  →  Lines  →  Straight Lines  →  Select Key point 1&2  →  Click OK. 
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Deformed Shape 

 

Shear force Diagram 

 

 

Bending Moment Diagram 
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6. Meshing 

a. Mesh Tool  →  Size control → Global → Size  →  Enter No. of Division  →  25  →  

OK. 

b. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

c. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (ON)  →  

OK 

d. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (OFF)  

→  OK 

7. Solution 

a. Solution  →  Define Loads  →  Apply Structural  →  Displacement  →  on Key Points  

→  Select key Points 1 and 2  →  Select (Ux , Uy)Constrained  → OK. 

b. Pressure  →  on Beam  →  Select Pick all  →  OK  →  enter the value = 100  →  OK. 

c. Solution  →  Solve  →  Current LS  →  OK. 

8. General Post proc 

a. General Post proc  →  Plot Results  →  Deformed Shape  →  Def + Undeformed  →  

OK. 

b. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

c. Element Table  →  Define Table  →  Add  →  Select By Sequence  → SM1SC,2  → 

apply,  

Select By Sequence  → SM1SC,6  →  apply 

Select By Sequence  → SM1SC,8  →  apply 

Select By Sequence  → SM1SC,12  →  apply  →  OK. 

 

9. Plot Result 

a. Plot Result  →  Contour Plot  → Line Element Resolution  →  Select SMISC2 + 

SMISC8 for S.F.D.  →  OK 

b. UtilityMenu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

c. Select SMISC6 + SMISC12 for B.M.D.  →  OK 

d. UtilityMenu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

Inference: 

          Analysis of beam is used mainly in civil engineering (Eg: Bridges, Roof structures) 

Result: 

   Thus the deformed shape, shear force diagram and Bending moment diagram are 

plotted for the simply supported beam with UDL using ANSYS software 

***********************
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Ex No : 3(c)                         Date : 

 

Stress Analysis of Fixed End Beam with Point Load 

 

 

 

 

 

 

 

 

Problem Specification: 

` 

E =  2.1e11 N/m
2
    =  0.3   Izz  =  0.0833m

4
 

L  =  12m     a  =  1m 

b  =  1m     

Aim:  

To find the deformed shape, shear force diagram and bending moment diagram for 

Fixed end Beam with point load. 

Procedure: 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2.Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 1 ,Izz = 0.083333 , Height = 1  →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 2.1e11  →  Prxy : 0.3   →  Ok 

b. Materials   →  Exit    

5. Modeling 

a. Modeling  →  Create  →  Key points  →  In active CS  →  Select Key point. 

b. 1  →  0,0,0  2  →  6,0,0  3  →  12,0,0 

c. Lines  →  Lines  →  Straight Lines  →  Select Key point 1&2and 2&3  →  Click OK. 
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20ME6L1   Computer Aided Simulation and Analysis Laboratory KLNCE 

 

CAD Laboratory 33 

 

6. Meshing 

a. Meshing  →  Size control → Global →Size  →  select the line  →  Enter No.of 

Divisions= 25  →  OK. 

b. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

c. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (ON) →  

OK  

d. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (OFF) →  

OK  

7. Solution 

a. Solution  →  Define Loads  →  Apply Structural  →  Displacement  →  on Key Points  

→  Select key Points 1 and 3  →  Select All DOF Constrained  → Click OK. 

b. Force moment  →  on key point 2 (Centre)  →  Select (FY)  →   Enter Value of  - 1000  

→  Click OK. 

c. Solution  →  Solve  →  Current LS  →  OK. 

8. General Post proc 

a. General Post proc  →  Plot Results  →  Deformed Shape  →  Def + Undeformed  →  

OK. 

b. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

c. Element Table  →  Define Table  →  Add  →  Select By Sequence  → SM1SC,2  → 

apply,  

d. Select By Sequence  → SM1SC,6  → apply 

e. Select By Sequence  → SM1SC,8  → apply 

f. Select By Sequence  → SM1SC,12  → apply  →  OK. 
 

9. Plot Result 

a. Plot Result  →  Contour Plot  → Line Element Resolution  →  Select SMISC2 + 

SMISC8 for S.F.D.  →  OK 

b. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

c. Select SMISC6 + SMISC12 for B.M.D.  →  OK 

d. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

Inference: 

Analysis of beam is used mainly in civil engineering (Eg: Bridges, Roof structures) 

Result: 

   Thus the deformed shape, shear force diagram and Bending moment diagram are 

plotted for the Fixed End Beam with point load using ANSYS software. 

******************** 
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Ex No : 4                            Date : 

Stress Analysis of A Plate With A Circular Hole 

 

 

 

 

 

 

 

 

 

 

Consider the square plate of uniform thickness with a circular hole with dimensions 

shown in thefigurebelow.Thethicknessoftheplateis1mm.TheYoung'smodulus E=107MPa 

and the Poissonratiois0.3. A uniform pressure = 1MPa act son the boundary of the hole. 

Assume that plane stress conditions prevail. Find stress and displacement fields using 

ANSYS software. 

 

     E  =  1e13 N/m
2
   γ  =  0.3   P  = 1e6 N/m

2 

     a  =  10e-3 m    r  = 7e-3 m 

Aim: 

To find the deformation shape and nodal stress analysis of rectangular component 

with hole. 

1. Preferences 

a. Main Menu   →   Preferences   →  Structural   →   OK. 

2. Element Type 

a. Element Type   →   Add / Edit / Delete   →   Add...   →   Pick Structural Solid   →  

Quad4node42   →   OK 

3. Real Constants 

a. Real Constants   →   Add / Edit / Delete > Add   →   OK. 

4. Materials Props 

a. Material Props   →   Material Models....  →   Structural, Linear, Elastic, and Isotropic   

→   Enter EX, = 1e13 , PRXY = 0.3 Click OK. 
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5. Modeling 

a. Modeling   →   Create   →   Areas   →   Rectangle   →   By 2 corners  →   

X=0,  Y = 0,               width = 10e-3, height = 10e-3 

b. Modeling   →   Create   →   Areas   →   Circle   →   solid circle  →   WP X 

= 0 ,  WP Y = 0 ,                Rad   = 7e-3 

c. Modeling   →   Operate   →    Booleans   →   Subtract   →   Areas   →   pick 

square area by using left mouse button  →   OK.   →  pick circular a r e a   →   

Click OK. 

6. Meshing 

a. Mesh Tool   →   click smart size   →   set size  = 5   →   free mesh   →   pick the 

area   →   OK. 

7. Solution 

a. Loads   →  Define Loads   →  Apply   →   Structural   →   Displacement   →   

Symmetry B.C.    →    On Lines    →    Select left and bottom edges    →    OK. 

b. Loads   →   Define Loads   →   Apply   →   Structural   →   Pressure  →  

On Lines  →  Pressure Value = 1e6   →   OK. 

c. Solve  →  Current LS   →   OK. 

8. General Post proc 

a. General Post proc  →  Plot Results  →  Deformed Shape   →  Select(Def + 

undeformed) and click OK. 

b. Utility Menu  →  Plot Ctrls   →  Hardcopy   →  To file   →   pick JPEG   →   save 

to (enter file name) 

c. Utility Menu  →  Plot Ctrls  →  Animate  →  Deformed Shape...   →  Select Def + 

undeformed and click OK 

d. General Post proc   →   Plot results   →  Contour Plot  →  Nodal Solu  →  Select 

Stress from the left list, vonmises from the right list and click OK 

e. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save 

to (enter file name) 

 

Inference: 

Stress–strain analysis (or stress analysis) is an engineering discipline covering methods to 

determine the stresses and strains in materials or structures which is having a hole at the 

center and subjected to forces or loads. 

Result:  

Thus the deformation shape and nodal stress diagram of Rectangular plate with 

circular hole is plotted using ANSYS software. 

******************* 
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Ex No : 5                          Date : 

Stress analysis of an axi – symmetric component 

 

 

 

 

Problem definition: 

The model will be that of a closed tube made from steel. Point loads will be applied 

at the center of the top and bottom plate to make an analytical verification simple to 

calculate. A 3/4 cross section view of the tube is shown below. As warning, point loads will 

created is continuities in your model near the point of application. If you chose to use these 

types of loads in your own modeling, be very careful and be sure to understand the theory 

of how the FEA package is Appling the load and the assumption it is making. In this case, 

we will only be concerned about the stress distribution far from the point of application, so 

the discontinuities will have a negligible effect. 

    E =2e5 

                                                                     =0.3 
 

               100N           All dimensions are in mm 

Aim:  

To find out deformation shape and stress analysis of an axi-symmetric component using 

ANSYS software. 

Steps : 

1.  Preferences   2.  Element Type   3.  Real Constants  

4.  Materials Props  5.  Modeling    6.  Meshing   

7.  Solution    8.  General Post proc 

1. Preferences     

a. Main Menu  →  Preferences   →  Structural   →   OK. 
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2. Element Type 

a. Element Type  →  Add/Edit/Delete  →  Add...   →  Pick Structural Solid   →  Quad 8  

node 82   →   OK 

b. Element Type   →   Options   →   Select the Axisymmetric   →   OK 

3. Real Constants 

a. Real Constants  →  Add/Edit/Delete>Add   →   OK. 

4. Materials Props 

a. Material Props  →  Material Models....  →  Structural, Linear, Elastic, and Isotropic   

→  Enter EX, = 2e5 , PRXY = 0.3 Click OK. 

5. Modeling 

a. Modeling  →   Create  →   Areas  →   Rectangle  →   By 2 corners  →  X = 0 

,Y = 0 ,W = 20 , H = 100   →   OK. 

b. Modeling  →   Create  →   Areas  →   Rectangle  →   By 2 corners  →  X = 0 

,Y = 5 ,     W = 15 , H = 90   →   OK. 

c. Modeling  →   Operate  →   Booleans  →   Subtract  →  Areas   →  pick First 

Rectangular area   →   OK.   →  pick Second Rectangular area   →   OK.  

6. Meshing 

a. Mesh Tool  →  set area  →  pick Area  →  OK  → Element Size  → 2  →  OK. 

b. Mesh Tool  →  Mesh   →   Free Mesh   →  pick Area  →  OK. 

7. Solution 

a. Solution  →  Define Loads  →   Apply  →   Structural  →  Displacement   →  

Symmetry B.C.   →  On Lines   →   Rectangular Select left Top & Bottom edges   →   

OK. 

b. Utility Menu  →   Select   →   Entities   →  By Location  →   Y Co-ordinates  →  50  

→  OK. 

c. Define Load  →  Displacement  →  on node  →  Pick all  →  UY  →  Displacement 

Value = 0  →  OK. 

d. Utility Menu  →   Select   →   Entities   →   By Location  →   Select all  →  Cancel. 

e. Define Load  →  apply  →  Structural  →  Force Moment  →  on Key point  →  pick 

Left Top Corner  →  enter the Value  → FY  → 100  → OK →  pick the left bottom 

corner  →  enter the Value  →  FY  →  -100  →  OK 

f. Solve  →  Current L.S.  →  OK  →  Solution is done  →  Close 
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8. General Post proc 

a. General Postproc  →  List Result  →  Nodal Solution  →  Stress  →  X – 

component  →  result copy word document past  →  OK. 

b. General Postproc  →  Plot Results  →  Deformed Shape   →  Select Def + 

undeformed and click OK. 

c. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

d. Utility Menu  →  Plot Ctrls  →  Animate  →  Deformed Shape...   →  Select Def + 

undeformed and click OK 

e. General Postproc  →  Contour Plot  →  Nodal Solution  →  Stress  →  Vonmises 

Stress  →  OK 

f. Utility Menu  →  Plot Ctrls  →   Hardcopy   →  To file   →   pick JPEG   →   save to 

(enter file name) 

 

Inference: 

With the help of modeling we can understand the use of axisymmetric component in 

engineering field (Eg: Boiler) 

Using Stress–strain analysis (or stress analysis) is an engineering discipline covering 

methods to determine the stresses and strains in materials or structures subjected to forces or 

loads. 

Result:  

Thus the deformation shape and nodal stress diagram of an axisymmetric 

component is plotted using ANSYS software. 

 

 

************************ 
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Ex No 6(a)                          Date : 

Conductive heat transfer analysis of 2D component 

 

 

 

 

 

 

 

Problem Specification: 

 

 Rectangular plate of Breadth = 0.4 m , height = 0.6 m. The upper and bottom edge of the 

plate temperature is taken as 180˚C. The right end of plate temperature is 190˚.C. Thermal 

conductivity = 1.5 w/mk. 

Aim:  

To find the temperature distribution on given plate 

1. Preferences 

a. Main Menu  →  Preferences   →  Thermal  →   OK. 

2. Element Type 

a. Element Type  →  Add/Edit/Delete  →  Add...   →  Pick Solid   →  Quad4node55   

→   OK 

3. Materials Props 

a. Material Props  →  Material Models....  →  Thermal, Conductivity ,Isotropic  → KXX, 

= 1.5Click OK. Material  →  Exit. 

4. Modeling 

a. Modeling  →   Create  →   Areas  →   Rectangle  →   By 2 Corner  →   X = 

0,Y = 0 ,Width =0.4 , Height = 0.6  →   OK. 

5. Meshing 

a. Meshing  →  Size Cntrls  →  Manual Size  →  Global  →  Size  →  0.05  →  OK 

b. Mesh Tool  →  Mesh  →  Select Surface  →  OK 
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6. Solution 

a. Solution →  Define Loads  →  Apply  →  Thermal   →  Heat Generate  →  On 

Lines   →  Select the Left Side of Rectangular Pick   →   OK  →  Value : 0  →  OK. 

b. Solution   →  Define Load  →  apply  →  Thermal  →  Temperature   →  Click the 

upper and bottom of the rectangular pick  →  OK  →  All DOF  →  Value : 180˚  →  

Right Side Pick  →  Value = 190˚ C  →  OK 

c. Solution  →  Solve  →  Current L.S.  →  OK  →  Solution is done  →  Close 

7. General Post proc 

a. General Postproc  →  Plot results  →  Contour Plot  →  Nodal Solu  →  DOF 

Solution  →  Nodal Temperature  →  OK 

 

Inference:  

Thermal analysis is also often used as a term for the study of heat transfer through 

structures. Many of the basic engineering data for modeling such systems comes from 

measurements of heat capacity and thermal conductivity. 

 

Result: 

Thus the temperature distribution diagram is plotted using ANSYS software. 

 

*************** 

 

 



KLNCE  ANSYS  Manual 

 

48 CAD Laboratory  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



20ME6L1   Computer Aided Simulation and Analysis Laboratory KLNCE 

 

CAD Laboratory 49 

 

Ex No : 6(b)                         Date : 

Thermal  analysis of 2D Plate (Conductive/Convective/Insulated) 

 

 

 

 

 

 

Problem Definition 

 The Mixed Convection / Conduction / Insulated Boundary Conditions Example is 

constrained as shown in the following figure (Note that the section is assume to be in 

finitely long). Find the temperature distribution. 

 

Aim: 

To find the temperature distribution on the given plate using ANSYS software. 

1.Preferences 

a. Main Menu  →  Preferences   →  Thermal  →   OK. 

2. Element Type 

a. Element Type  →  Add/Edit/Delete  →  Add…  →  Pick Solid   →  Quad4 node55   

→   OK 

3. Materials Props 

a. Material Props  →  Material Models….   →  Thermal, Conductivity ,Isotropic  → 

KXX, = 10Click OK. Material  →  Exit. 

4. Modeling 

a. Modeling  →   Create  →   Areas  →   Rectangle  →   By 2 Corner  →   X = 

0,Y = 0 ,Width =1 , Height = 1  →   OK. 

5. Meshing 

a. Meshing  →  Size Controls  →  Manual Size  →  Global  →  Size  →  Area Controls  

→  length: 0.05  →  OK 

b. Mesh Tool  →  Mesh  →  Select Surface  →  OK 
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6. Solution 

a. Solution →  Define Loads  →  Apply  →  Thermal   →  On Lines   →  Select the 

Top Edge Rectangular Pick   →   OK  →  All DOF,Value:500  →  OK. 

b. Solution →  Define Loads  →  Apply  →  Thermal   →  On Lines   →  Select the 

left Edge Rectangular Pick   →   OK  →  All DOF, Value: 100  →  OK. 

c. Solution   →  Define Load  →  apply  →  Convection  →  on lines  →  Select the Right 

Side Pick  →  OK  →  Film Coefficient : 10 , Bulk Temperature : 100  →  OK. 

d. Solution  →  Define Load  →  apply  →  Convection  →  on lines  →  Select the Bottom 

Side Pick  →  OK  →  Value:0,Value: 0  →  OK. 

e. Solution  →  Solve  →  Current L.S.  →  OK  →  Solution is done  →  close 

7. General Post proc 

a. General Postproc  →  Plot results  →  Contour Plot  →  Nodal Solu  →  DOF 

Solution  →  Nodal Temperature  →  OK 

 

Inference: 

Thermal analysis is also often used as a term for the study of heat transfer through 

structures. Many of the basic engineering data for modeling such systems comes from 

measurements of heat capacity and thermal conductivity. 

 

Result:  

Thus the temperature distribution diagram is plotted using ANSYS software. 

******************* 
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Ex No : 7                          Date : 

Thermal stress analysis of cylindrical shells 

 

 

 

 

 

 

 

Problem Specification: 

compute the temperature distribution in a long steel cylinder with inner radius 5 inches and 

outer radius 10 inches.  The interior of the cylinder is kept at 75 deg F, and heat is lost on the 

exterior by convection to a fluid whose temperature is 40 deg F.   The convection coefficient 

is 0.56 BTU/hr-sq.in-F and the thermal conductivity for steel is 0.69 BTU/hr-in-F. 

            EX = 3.E7 (psi) 

            DENS = 7.36E-4 (lb sec^2/in^4) 

            ALPHAX = 6.5E-6 

            PRXY = 0.3 
            KXX = 0.69 (BTU/hr-in-F) 

Aim: 

To find the temperature distribution on the given cylindrical shells using ANSYS 

software. 

1.Preferences 

a. Main Menu  →  Preferences   →  Thermal  →   OK. 

2. Element Type 

a. Element Type  →  Add/Edit/Delete  →  Add…  →  Thermal Solid   →  solid 8 

node 77  →   OK →  options  →  elements behavior  →  Axi symmetric  →  

OK 

3. Materials Props 

a. Material Props  →  Material Models….   →  Thermal, Conductivity ,Isotropic  → 

KXX, = 0.69  Density  →  7.36e-4 →  OK →   

b. Favorites  →  Linear static  →  Linear isotropic  →  EX=3e7  →  PRXY =0.3 →  

Thermal expansion  →  ALPHAX=6.5E-6 →  Click OK. Material  →  Exit. 

4. Modeling 

a. Modeling  →   Create  →   Areas  →   circle  →   Partial Annulas→   X = 0,Y 

= 0 rad1 =5 →  theta1 = 0 →  rad2=10 →  theta2 = 90 →   OK. 

5. Meshing 

a. Meshing  →  Size Controls  →  Manual Size  →  Global  →  Size  →  Edge length 

=2  →  →  OK 

b. Mesh Tool  →  Mesh  →mapped →    Select Surface  →  OK 
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6. Solution 

a. Solution →  Define Loads  →  Apply  →  Thermal   →  on nodes   →  Select 

inner circular nodes   →   temperature =75 →  OK  →   

b. Solution →  Define Loads  →   Apply  →  Thermal   → convection →   On 

Lines   →  Select outer circular line   →   OK  → Film Coefficient : 0.56 , Bulk 

Temperature : 40  →  OK. 

c.  Solution   →  Define Load  →  apply  →  Convection  →  on lines  →  Select vertical 

and horizontal line  →  OK  →  Film Coefficient : 0 , Bulk Temperature : 0  →  OK. 

d. Solution  →  Solve  →  Current L.S.  →  OK  →  Solution is done  →  close 

 

7. General Post proc 

a. General Postproc  →  Plot results  →  Contour Plot  →  Nodal Solution  →  DOF 

Solution  →  Nodal Temperature  →  OK 

Inference: 

Thermal analysis is also often used as a term for the study of heat transfer through 

structures. Many of the basic engineering data for modeling such systems comes from 

measurements of heat capacity and thermal conductivity. 

Result:  

Thus the temperature distribution diagram is plotted using ANSYS software. 

 

***************** 
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Ex No : 8                          Date : 

Vibration analysis of spring mass system 

 

 

 

 

 

 

 

Problem Specification: 

 
 

Find the 2 mode frequency analysis of spring mass system 

 

Notes: ANSYS has an option that will allow for the masses to be modeled as point masses.  Using this 

option, no dimensions or material properties would be necessary for the masses.  However, so that 

the mode shapes are easier to understand when they are animated, in this case, the masses will be 

modeled as blocks, 1 m x 1 m, with unit thickness.  So, they have a volume of 1 m3.  The densities will 

be specified to produce the correct masses.  Also, the free lengths of the springs are irrelevant in this 

analysis, as only the stiffnesses matter.  But, they will both be assumed to have a length of 5 m.    

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Solid   →  Quad 4 node 42 

→   apply   →  Combination  →  Spring damper 14    →  OK 

3. Real Constants 

a. Real Constants   →  select element 2 →  Add / Edit / Delete   →  Add  →  set no 

1→K =5 →OK →Add → for set no 2→K=20→  OK     

 

 

M= 2 kg

x1 x2

K= 5 N/m K= 20 N/m
M= 1 kg
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****  INDEX OF DATA SETS ON RESULTS FILE  ***** 
 

SET   TIME/FREQ    LOAD STEP   SUBSTEP  CUMULATIVE 
1 0.20252             1         1         1 
2 0.88443             1         2         2 
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  4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 1  →  Prxy : 0.27   →  Ok → density =2 → 

material→new model→ Structural   →  Linear   →  Elastic   →  Isotropic   →  Ex: 1  

→  Prxy : 0.27   → density =1  →Ok 

Materials   →  Exit    

5. Modeling 

a. Modeling  →  Create  →  Areas →Rectangle →by 2 corners →enter X=5, Y=0, Width 

=1, Height =1→apply→ enter X=11, Y=0, Width =1, Height =1 →  OK 

6. Meshing 

a. Meshing  →  Size Cntrls  →  Manual Size  →  Global  →  Size  →  Enter NDIV=1  →  

OK. 

b. Mesh Tool  →  Mesh  area → mapped →select left side area  →  OK  

c. Modeling → create → element → element attributes →Material No.= 2 

d. Mesh Tool  →  Mesh  area → mapped →select right side area  →  OK  

e. Plot controls  →  Window controls  →  window options  →  triad  →  not shown. 

f. Plot  →  nodes. 

g. Modeling  →  Create  →  Nodes → in active co systems → Node no 9 → OK 

h. Modeling → create → element → element attributes →Element type 2 → Material 

No.1→real constant no.1→ OK 

i. Modeling → create → element →Auto numbered →through nodes→pick node 9 

and1→OK 

j. Modeling → create → element → element attributes →Element type 2 → Material 

No.1→ real constant no.1→ → OK 

k. Modeling → create → element →Auto numbered →through nodes→pick node 2 and 

5→ OK 

7. Solution 

a. Solution  →  Define Loads  →  Apply  →  Structural  →  Displacement  →  on nodes  

→  Select all nodes →  select UY and UZ →  OK 

b. On nodes →  select node 9 →  select all DOF →  OK 

c. Preprocessor →  coupling/ceqn →  couple DOFS →  select nodes1, 2, 3 ,4 →  set UX 

NSET = 1→  OK 
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d. Couple DOFS →  select nodes 5,6,7,8→  set UX NSET =2→  OK Ansys Type  →  

New Ansys  →  Modal  →  OK 

e. Ansys Options  →  PCG Lanczous  →  No. of Modes to extract 2  →  Expand 2  →  

OK  →  OK. 

f. Solve →  current L.S→  OK. 

 

8. General Post proc 

a. General Post proc  →  Results Summery  →  the result copy Word past  →  OK. 

b. Read Result  →  Select First Set  →  Plot Result  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

c. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

d. Read Result  →  Select Last Set  →  Plot Resutl  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

e. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

f. Plot Ctrls  →  Animate  →  Deformed Shape  →  Click Def + Undeformed  →  OK. 

Inference: 

Model analysis is used for finding the mode of natural frequency of a given member. 

We can understand that the frequency of vibration depends on mass, geometry value 

and stiffness of that element. 

Result: 

Thus we plotted the 2 mode frequency analysis of Spring Mass system using ANSYS 

software. 

 

******************** 
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Ex No : 9(a)                         Date : 

Modal Analysis of Cantilever Beam 

 

 

 

 

 

 

 

 

Problem Specification: 

 

Find the 5 mode shape analysis of given Cantilever Beam. 

E = 206800e6  N/m
2
   = 0.27  Izz  = 8.33e-10 m

4 

          Density   = 7830  kg/m
3
    a =  0.01m b  =  0.01m     

Area = 0.0001m
2
 

Aim:  

To find 5 mode frequency analysis of Cantilever Beam using ANSYS software. 

1.Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

b. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 0.0001 ,Izz = 8.33e
-10

 , Height = 0.01  →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 206800e
6
  →  Prxy : 0.27   →  Ok 

b. Density  →  7830  →  OK. 

c. Materials   →  Exit    

5. Modeling 

a. Modeling  →  Create  →  Key points  →  In active CS  →  Select Key point. 

b. 1  →  0,0,0  2  →  1,0,0 

c. Lines  →  Lines  →  Straight Lines  →  Select Key point 1,2  →  Click OK. 
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*****  INDEX OF DATA SETS ON RESULTS FILE  ***** 
 

SET   TIME/FREQ    LOAD STEP   SUBSTEP  CUMULATIVE 
1  8.2996             1         1         1 
2  52.009             1         2         2 
3  145.60             1         3         3 
4  285.25             1         4         4 
5  471.39             1         5         5 
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6. Meshing 

a. Meshing  →  Size Cntrls  →  Manual Size  →  Global  →  Size  →  Enter the Element 

Division  →  25  →  OK. 

b. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

c. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (ON). 

7. Solution 

a. Ansys Type  →  New Ansys  →  Model  →  OK 

b. Ansys Options  →  PCG Lanczous  →  No. of Modes to extract 5  →  Expand 5  →  

OK  →  OK. 

c. Solution  →  Define Loads  →  Apply  →  Structural  →  Displacement  →  on Key 

Points  →  Select key Points 1  → Left Side Click OK   →  Select All DOF 

Constrained. 

d. Solution  →  Solve  →  Current LS  →  OK. 

8. General Post proc 

a. General Post proc  →  Results Summery  →  the result copy Word past  →  OK. 

b. Read Result  →  Select First Set  →  Plot Result  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

c. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

d. Read Result  →  Select Next Set  →  Plot Result  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

e. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

f. Read Result  →  Select Next Set  →  Plot Result  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

g. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

h. Read Result  →  Select Next Set  →  Plot Result  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

i. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

j. Read Result  →  Select Next Set  →  Plot Result  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

k. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

l. Plot Ctrls  →  Animate  →  Deformed Shape  →  Click Def + Undeformed  →  OK. 
 

Inference: 

 Model analysis is used for finding the mode of natural frequency of a given member. 

 We can understand that the frequency of vibration depends on mass, geometry value and 

stiffness of that element. 

Result: 

 Thus we plotted the 5 mode shape analysis of Cantilever Beam using ANSYS software. 

*********************** 
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Ex No : 9 (b)                         Date : 

Model Analysis of Simply Supported Beam 

 

 

 

 

 

 

 

Problem Specification: 

 

 

E  =  206800e6 N/m
2
   =  0.27  Izz = 8.33e-10 

          Density    =  7830 kg/m
3
    a  =  0.01m 

b   =  0.01m     Area =  0.0001m
2
 

Aim:  

To find 5 mode frequency analysis of simply supported beam using ANSYS software. 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 0.0001m ,Izz = 8.33e
-10

m
4
 , Height = 0.01m  →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 206800e
6
  →  Prxy : 0.27   →  Ok 

b. Density  →  7830  →  OK. 

c. Materials   →  Exit    

5. Modeling 

a. Modeling  →  Create  →  Key points  →  In active CS  →  Select Key point. 

b. 1  →  0,0,0  2  →  1,0,0 

c. Lines  →  Lines  →  Straight Lines  →  Select Key point 1,2  →  Click OK. 
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*****  INDEX OF DATA SETS ON RESULTS FILE  ***** 
 

SET   TIME/FREQ    LOAD STEP   SUBSTEP  CUMULATIVE 
1  52.813             1         1         1 
2  145.56             1         2         2 
3  285.30             1         3         3 
4  471.50             1         4         4 
5  704.13             1         5         5 
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6. Meshing 

a. Meshing  →  Size Cntrls  →  Manual Size  →  Global  →  Size  →  Enter the Element 

Division  →  25  →  OK. 

b. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

c. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (ON). 

7. Solution 

a. Ansys Type  →  New Ansys  →  Model  →  OK 

b. Ansys Options  →  PCG Lanczous  →  No. of Modes to extract 5  →  Expant 5  →  

OK  →  OK. 

c. Solution  →  Define Loads  →  Apply  →  Structural  →  Displacement  →  on Key 

Points  →  Select key Points 1  →  Left Side & 2 →  Right Side Click OK   →  Select 

UX,UY Constrained. 

d. Solution  →  Solve  →  Current LS  →  OK. 

8. General Post proc 

a. General Post proc  →  Results Summery  →  the result copy Word past  →  OK. 

b. Read Result  →  Select First Set  →  Plot Resutl  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

c. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

d. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

e. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

f. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

g. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

h. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

i. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

j. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

k. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

l. Plot Ctrls  →  Animate  →  Deformed Shape  →  Click Def + Undeformed  →  OK. 

Inference: 

Model analysis is used for finding the mode of natural frequency of a given member. 

We can understand that the frequency of vibration depends on mass, geometry value 

and stiffness of that element. 

Result:  

Thus we plotted the 5 mode frequency analysis of simply supported Beam using 

ANSYS software. 

************************** 



KLNCE  ANSYS  Manual 

 

70 CAD Laboratory  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



20ME6L1   Computer Aided Simulation and Analysis Laboratory KLNCE 

 

CAD Laboratory 71 

 

Ex No : 9(c)                         Date : 

Model Analysis of Fixed End Beam 

 

 

 

 

 

 

 

Problem Specification: 

 
 

Find the 5 mode frequency analysis of Fixed End Beam 

E = 206800e6 N/m
2
   = 0.27   Izz = 8.33e-10 

          Density    = 7830 kg/m
3
    a = 0.01m 

b  = 0.01m     Area  = 0.0001m
2
 

Aim:  

To find 5 mode frequency analysis of Fixed End Beam using ANSYS software. 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

3. Real Constants 

a. Real Constants   →  Add / Edit / Delete   →  Add  →  OK     

b. Enter  →  Area = 0.0001 ,Izz = 8.33e
-10

 , Height = 0.01  →  Click OK. 

4. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 206800e6  →  Prxy : 0.27   →  Ok 

b. Density  →  7830  →  OK. 

c. Materials   →  Exit    

5. Modeling 

b. Modeling  →  Create  →  Key points  →  In active CS  →  Select Key point. 

c. 1  →  0,0,0  2  →  1,0,0 

d. Lines  →  Lines  →  Straight Lines  →  Select Key point 1,2  →  Click OK. 
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*****  INDEX OF DATA SETS ON RESULTS FILE  ***** 
 

SET   TIME/FREQ    LOAD STEP   SUBSTEP  CUMULATIVE 
1  52.813             1         1         1 
2  145.56             1         2         2 
3  285.30             1         3         3 
4  471.50             1         4         4 
5  704.13             1         5         5 
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6. Meshing 

l. Meshing  →  Size Cntrls  →  Manual Size  →  Global  →  Size  →  Enter the Element 

Division  →  25  →  OK. 

m. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

n. Plot Cltrs (Main Menu)  →  Style  →  Size and shape  →  Display of Element (ON). 

7. Solution 

a. Ansys Type  →  New Ansys  →  Model  →  OK 

b. Ansys Options  →  PCG Lanczous  →  No. of Modes to extract 5  →  Expant 5  →  

OK  →  OK. 

c. Solution  →  Define Loads  →  Apply  →  Structural  →  Displacement  →  on Key 

Points  →  Select key Points 1  →  Left Side & 2 →  Right Side Click OK   →  Select 

All DOF Constrained. 

d. Solution  →  Solve  →  Current LS  →  OK. 

 

8. General Post proc 

a. General Post proc  →  Results Summery  →  the result copy Word past  →  OK. 

b. Read Result  →  Select First Set  →  Plot Resutl  →  Deformed Shape  → Click Def+ 

undeformed  →  OK 

c. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

d. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

e. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

f. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

g. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

h. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

i. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

j. Read Result  →  Select Next Set  →  Plot Resutl  →  Deformed Shape  →  Click Def+ 

undeformed  →  OK 

k. Plot Ctrls  →  Hard copy  →  to file JPG  →  OK 

l. Plot Ctrls  →  Animate  →  Deformed Shape  →  Click Def + Undeformed  →  OK. 

Inference: 

Model analysis is used for finding the mode of natural frequency of a given member. 

We can understand that the frequency of vibration depends on mass, geometry value 

and stiffness of that element. 

Result: 

Thus we plotted the 5 mode frequency analysis of Fixed End Beam using ANSYS 

software. 

**********************
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Ex No : 10                         Date : 

Harmonic Analysis Of Cantilever Beam 

 

 

 

 

 

 

 

Problem Specification: 

 We will now conduct a harmonic forced response test by applying a cyclic load 

(harmonic) at the end of the beam. The frequency of the load will be varied from                          

1-100Hz.The figure below depicts the beam with the application of the load. 

 

     E  =  206800e
6
 N/m

2
    =  0.27    Izz  =  833e-12 

D =  7830Kg/m
3
    a  =  0.0001m

2
   h  =  0.01 m 

Aim: 

To find the harmonic analysis of Cantilever Beam using ANSYS software. 

Procedure: 

1. Preferences 

a. Click  →  Main Menu  → Preferences  →  Click Structural  →  Click OK. 

2. Materials Props 

a. Preprocessor   →  Materials Props   →  Materials Models   →  Structural   →  Linear   

→  Elastic   →  Isotropic   →  Ex: 206800e6  →  Prxy : 0.27   →  Ok 

b. Density  →  7830  → OK. 

c. Materials   →  Exit    

3. Element Type 

a. Element Type   →  Add / Edit / Delete   →  Add   →  Beam   →  2D Elastic 3   →  OK 

4. Real Constants 

a. Real Constants  →  Add / Edit / Delete  →  Add  →  OK     

b. Enter  →  Area = 0.0001m
2
 ,Izz = 833e-12 , Height = 0.01m  →  Click OK. 
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***** ANSYS POST26 VARIABLE LISTING ***** 
 

TIME                 2 UY 
UY_2 

AMPLITUDE       PHASE 
1.0000        0.196269       0.00000 
2.0000        0.205086       0.00000 
3.0000        0.221743       0.00000 
4.0000        0.250351       0.00000 
5.0000        0.300534       0.00000 
6.0000        0.399155       0.00000 
7.0000        0.656309       0.00000 
8.0000         2.65172       0.00000 
9.0000         1.06273       180.000 
10.000        0.410080       180.000 
11.000        0.242418       180.000 
12.000        0.166333       180.000 
13.000        0.123260       180.000 

14.000        0.957484E-01   180.000 
15.000        0.767763E-01   180.000 
16.000        0.629764E-01   180.000 
17.000        0.525351E-01   180.000 
18.000        0.443899E-01   180.000 
19.000        0.378782E-01   180.000 

 
***** ANSYS POST26 VARIABLE LISTING ***** 
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5. Modeling 

a. Modeling  →  Create  →  Key points  →  In active CS  →  Select Key point. 

b. 1  →  0, 0, 0  2  →  1, 0, 0 

c. Lines  →  Lines  →  Straight Lines  →  Select Key point 1, 2  →  Click OK. 

6. Meshing 

a. Mesh Tool →  Set line  →  Enter the Element Division  →  25  →  OK. 

b. Mesh Tool  →  Mesh  →  (Select the line)  →  OK  

7. Solution 

a. Solution → Analysis  Type → New Analysis → Harmonic ANTYPE, 3 →  OK. 

b. Solution → Analysis Type → Analysis Options. → OK  →  OK 

c. Solution → Define Loads → Apply → Structural →  Displacement →  on key point    

→  Click Left Side keypoint →  OK  →  Select All DOF Constrained  →  OK. 

d. Select Solution → Define Loads → Apply → Structural → Force/Moment → on key 

point  →   Click Right Side key Point  →  OK  →  Direction of  Force – FY  →  Real 

Part of Force  → 100 ; Image Part of Force – 0  →  OK 

e. Solution  →  Load Step Opts  →  Time/Frequency  → Freq and Substps... →  

Harmonice Freq Range – 0 – 100; Number of Sub step – 100  →  Select the Stepped  →  

OK. 

f. Solution → Solve → Current LS SOLVE  →  Solution done. 

8. TimeHistPostpro 

a. SelectTimeHistPostpro →  Click Add Data  →  Click DOF Solution  →  Click Y – 

Component of displacement  →  OK →  Cantilever Beam Right Side Point Click  →  

OK 

b. Select the List Data  →  Data List  →  Close 

c. Graph Data  →  Displace Hard Copy  →  to file JPG  → OK 

d. UtilityMenu → PlotCtrls → Style → Graphs → ModifyAxis → Select the – LOGY Y 

– axis Scale = Linear Change the Logarithmic  →  OK 

e. UtilityMenu>Plot>Replot 

Inference: 
Harmonic analysis is used for finding the mode of natural frequency of a given member  

in dynamic and/ or for dynamic loading condition. 

 We can understand that the frequency of vibration depends on mass, geometry value 

and stiffness of that element. 

Result: 

Thus the harmonic analysis is conducted on cantilever beam using ANSYS software 

and the results are plotted. 

*************************** 
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Ex No :                          Date : 

Non-Linear Analysis Using Contact Element 
 

 

 

 

 

 

 

Problem:  

 A set of punch and die with dimensions is as shown in the figure. The thickness for both 

punch and die is 0.1 mm. A force of 2000 N is applied at top of the punch. Analyze the stress 

distribution in punch as well die using contact elements. 

 

GUI Solution: 

1. Starting: 

Click  start  ANSYS  ANSYS product launcher 

Launch ANSYS Multiphysics 

File management  browse the directory for saving and retrieving the files. Click  run 

 

2. Preferences  tick  structural  select h-method  ok 

Title: 

Utility menu  File  Change title  “Machine part”  ok. 

Utility menu -> plot > replot 

 

4. Elements: 

Main menu  Preprocessor  element type  add  add  Structural  Solid  quad 

4node (PLANE42)  ok 

Set options  pane stress with thickness  ok 
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Main menu  Preprocessor  element type  add  add  Contact  2D target (TARGE 

169)  apply  2 nd surf 171 (CONTA171)  ok 

5. Real Constant: ( Contact material only needs Real Constants) 

(Punch is contact Die is Target) 

Main menu  Preprocessor  real constant  add  Type 1  ok  enter thickness as 0.1 

 ok 

 add  Type 2  ok  enter RI = 0.01 & R2 = 0.01  ok 

 add  Type 3  ok  enter RI = 0.01 & R2 = 0.01  ok  close 

6. Material Properties:  

(Main material only needs material properties) 

Main menu  Preprocessor  Material prop  Material models  Material model no 1  

Structural   Linear -» Elastic -> isotropic -> -> enter EX = 2.0e+05; NUXY = 0.3 -> ok. 

7.Modeling: 

Main menu  Preprocessor  create  keypoints  in active CS   

enter KPI = (0,0),  

KP2 = (30,0),  

KP3 = (30,25),  

KP4 = (20,25),  

KP5 = (10,25),  

KP6 = (0,25),  

KP7 = (10,25.01),  

KP8 = (20,25.01),  

KP9 = (20,75),  

KP10 = (10,75)  ok 

Main menu  Preprocessor  create  lines  st. lines  select KPI & KP2  apply   

select KP2 & KP3  apply   

select KP3 & KP4  apply   

select KP4 & KP5  apply   

select KP5 & KP6  apply   

select KP6 & KPI  apply   

select KP7 & KP8  apply   

select KP8 & KP9  apply   

select KP9 & KP10  apply   

select KP10 & KP7  ok 
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Utility menu  plotctrls  numbering  line no  on 

 

Utility menu  plot  lines 

 

Main menu  Preprocessor  modeling create  areas  arbitrary  by lines   

pick LI, L2, L3, L4, L5, L6  apply   

pick L7, L8, L9, L10  ok. 

Utility menu  plotctrls  numbering  line no  on 

Utility menu  select  everything 

Utility menu  plot  area 

Main menu  Preprocessor  meshtool  set  lines   

 select L3, L4, L7, L5, L9  apply   

 enter no. of division = 8  apply 

select LI, L2, L6  apply  enter no. of division = 10  apply 

select L8, L10  apply  enter no. of division = 15  apply  ok 

Main menu  Preprocessor  meshtool  mesh  area  pickall  ok. 

8. Creating Contact Elements: 

 

Utility menu  select  entities  lines  by num/pick  apply  select L7 (bottom line of 

the punch)  apply  ok 

 

Utility menu  select  entities  nodes  attached to  lines, all  apply > ok 

 

Utility menu  Utility menu  plot  nodes 

Main menu  Preprocessor  modeling  create  elements   

elements attributes select type 2 ;  

mat no 1 ;  

real constant set no 2  ok 

 

Main menu  Preprocessor  modeling  create  elements  Auto numbered  through 

nodes  pick adjacent two nodes at time  apply 

 

Utility menu  select  entities  lines  by num/pick  apply  select L4 (line on die 

below bottom line of the punch)  apply  ok. 

 

Utility menu  select  entities  nodes  attached to  lines, all  apply  ok 

 

Utility menu  plot  nodes 
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Main menu  Preprocessor  modeling  create  elements  elements attributes  select 

element type 3 ; mat no 1 ; real constant set no 3  ok. 

 

Main menu  Preprocessor  modeling create  elements  Auto numbered  through 

nodes  pick adjacent two nodes at time  apply 

 

Utility menu  select  everything 

 

Utility menu  plot multiplot 

Utility menu  select  entities  lines  by num/pick  apply  select L7 & L4 together 

 apply  ok. 

 

Utility menu  select  entities  nodes  attached to  lines, all  apply  ok 

 

Utility menu plot  nodes 

 

Preprocessor  Coupling/Ceqn  Couple DOF  pickall  set reference no 1 and select Uy 

 ok ( Contact Manag we can add friction) 

 

Utility menu  select  everything 

 

Utility menu  plot  multiplot 

 

9. Boundary Conditions: 

Utility menu  select  entities  lines  by num/pick  apply  select bottom most line 

 apply  ok. 

Utility menu  select  entities  nodes  attached to  lines, all  apply  ok 

Utility menu  plot  nodes 

Main menu  Solution  loads  apply  displacement  on nodes  select pickall  ok 

 select all DOF ok. 

Utility menu  Select  everything 

Utility menu  plot  multiplot 

Main menu  Solution  loads  apply  force  on nodes  select last but one node 

from right on the top of the punch  ok  enter Fy = -2000  ok 

10. Non Linear Settings: 

 

Main menu  solution  analysis type  new analysis  transient  full  ok 

Main menu  solution  analysis type  solun contrl  basic  

Analysis option  large displacement transient 
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Time control: 

Time at the end of load step  1 

Automatic time stepping  on 

Time increment  enter 0.01, 0.001, 0.25 

Write items to result file All solution items 

Frequency  for every substep 

 

Main menu  solution analysis type  solun contrl  Non-Linear  equilibrium iterations 

= 25. 

Main menu  Solution  solve  current LS 

 

11. Post Processing: 

Gen. post processor  plot results nodal solutions  stress  von-mises  ok 
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Ex No :                          Date : 

3D Static Analysis of a Pulley (Applying Angular Velocity and Torque) 

Applying  Torque by Mass Element 

 

 

 

 

 

 

 

Problem:  

 A pulley is rotating at 1000 rpm and require to transmit power of 5 kW. The dimensions of 

the pulley are shown in the figure. The material properties are young’s modulus is 210 GPa 

(2.1X103 N/mm2) and Poisson’s ratio is 0.3 and density is 7800 kg/m3. Analyze for the von-

mises stress. 

 

GUI Solution: 

1. Starting: 

Click  start ANSYS  ANSYS product launcher 

Launch  ANSYS Multiphysics 

File management  browse the directory for saving and retrieving the files. Click  run 

 

2. Preferences  tick  structural  select h-method  ok 

Title: 

Utility menu  File  Change title  “Machine part”  ok. 

Utility menu  plot replo 

3. Elements: 

Preprocessor  element type  add  add  structural solid  qudra 8 noded (PLANE42) 

 apply  add  brick with rotate (SOLID73) (not available in ANSYS v9 directly)  

apply  add  3D mass (MASS21)  apply 
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3.Real Constants: 

Preprocessor  real const  add  Qdd  select MASS 21  ok  enter set no = 3,  

MASSX = 0.0001,  

MASSY = 0.0001, MASSZ = 0.0001,  

IXX = 0.0001,  

IYY = 0.0001,  

IZZ = 0.0001  ok 

6. Material Properties: 

Preprocessor  material prop  constant  isotropic enter the material no as 1  ok  

enter the following values:  

EX = 2.1e+05;  

NUXY = 0.3  DENS = 7800e-09  ok 

7. Modeling:  

Material ID2 ;  

Ex = 1 ;  

NUXY =0.3 ;  

DENS 0.0001-> ok 

a. Main menu  Preprocessor  Modeling  create  keypoints  in active CS Enter 

the  

KPI = (0,0),  

KP2 = (100,0),  

KP3 = (0,7.5),  

KP4 = (0,20),  

KP5 = (20,20),  

KP6 = (20,30),  

KP7 = (50,42.5),  

KP8 = (50,52.5),  

KP9 = (100,52.5),  

KP10 = (100,7.5)  C ok. 

b. Main menu  Preprocessor  Modeling  create  lines  st. lines  pick the 

keypoints by sequence from KP3 to KP10  ok. 

c. Main menu  Preprocessor  Modeling  create  areas  arbitrary  pick all the 

lines  ok. 
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d. Main menu  Preprocessor  meshtool  size cntrl  manual size  size  enter 

SIZE = 2  ok. 

e. Main menu  Preprocessor  attributes  define  default attributes  set Element 

type  1, Mat. ID  1  ok. 

f. Main menu  Preprocessor  Mesh tool  mesh  area  pick all  ok. NO' visions 

g. Main menu  Preprocessor  meshtool  set global  No. of divisions = 8  ok.  

h. Main menu  Preprocessor  attributes  define  default attributes  set Element 

type 2, SOLID73, Mat. ID  1 ok.  

i. Main menu  Preprocessor  Modeling  operate  extrude  area  about axis  

pick all  enter the key points on the axis about which it is revolved 360, 4 3D object 

will be created. 

j. Main menu  Preprocessor  attributes  define  default attributes  set Element 

type  1 Mat. ID  1  ok 

k. Utility menu  select  elements  by attributes  Elem num type  enter min,  

max = 1  from, full  apply  ok. 

l. Utility menu  plot  elements 

m. Main menu  Preprocessor  Meshtool  select areas  clear  Select area 

corresponding 2D element  ok 

n. Main menu  Preprocessor  Modeling  create  nodes  in active CS  enter 

node no as 50000 (more than the maximum number of node) and x = 100, y = 0, z = 0 

ok 

o. Main menu  Preprocessor  modeling  create  element element attributes  

set element as 3, Mat ID as 1, Real cont as 1  ok 

p. Main menu  create  element  through  auto numbered  through nodes  pick 

50000
th

 node  ok. 

 

8. Application of Boundary conditions: 

 

Menu bar  select  entities areas  by num/pick  apply  select small end of the shaft 

which is fixed  apply  ok. 

Select  entities  nodes  attached to  areas, all  apply  ok. 

Menu bar  plot  nodes. 

Solution  loads  apply  displacement  on nodes  pickall  apply all DOF except 

ROTX (about which shaft rotate)  ok. 

Menu bar  Select everything. 
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Menu bar  plot  multiplot. 

9. Application of Angular velocity: 

Solution  loads  apply  others  angular velocity  enter the value of angular velocity 

(cox) = (2x  x 1000/60 = 104 r/s)  ok. 

10.Application of Torque: 

Torque is applied at the other end of the shaft at 52.5 mm radius 

Calculation of Torque: 

 

 

Coupling the Nodes: 

Utility menu  select  entities  node  by num/pick  apply  enter 11)000  ok. 

Utility menu  plot  nodes. 

Utility menu  plot  lines 

Utility menu  select  entities  lines  by num/pick  apply  select front end circle 

lines  ok. 

Utility menu  select  entities  node  attached to  lines, all  also select apply  ok. 

Utility menu  plot  nodes 

Main menu  Preprocessor  coupling/Ceqn  Rigid region  enter master node as 50000 

 apply select the circumferential nodes on the circle of the shaft  ok. 

In constraint equation for regid region table  enter Ld of -> all applicable, Ldof2  slave 

rotate ROTZ, LdofB  slave rotate ROTZ, Ldof4  slave rotate ROTZ  

(the direction in which axis shaft rotates)  ok 

Solution  solve  current LS 

 

11. General Post processing: 

Gen. post processor  plot results  nodal solution  stress  von-mises  
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Ex No : 11 (CBS)                              Date : 

Coupled Structural/Thermal Analysis  

 

 

 

 

 

 

 

Problem Specification: 

  

Length of the link  =  1m 

Area = 4e-4 m 

Element  =  Link 33(Thermal Mass Link 3D conduction) 

KXX = 60.5 

Mesh Edge length  = 0.1 m 

Element =  Link 8 

EX  :  200e9  

PRXY :  0.3  

ALPX :  12e-6  

When the input of one physics analysis depends on the results from another analysis, the 

analyses are coupled."  

Thus, each different physics environment must be constructed seperately so they can be 

used to determine the coupled physics solution. However, it is important to note that a single 

set of nodes will exist for the entire model. By creating the geometry in the first physical 

environment, and using it with any following coupled environments, the geometry is kept 

constant. For our case, we will create the geometry in the Thermal Environment, where the 

thermal effects will be applied.  
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Although the geometry must remain constant, the element types can change. For instance, 

thermal elements are required for a thermal analysis while structural elements are required to 

deterime the stress in the link. It is important to note, however that only certain combinations 

of elements can be used for a coupled physics analysis. 

Thermal Environment - Create Geometry and Define Thermal Properties  

1. Give example a Title  

Utility Menu > File > Change Title ... /title, Thermal Stress Example 

2. Open preprocessor menu  

ANSYS Main Menu > Preprocessor /PREP7 

3. Define Keypoints  

Preprocessor > Modeling > Create > Keypoints > In Active CS... K,#,x,y,z  

We are going to define 2 keypoints for this link as given in the following table:  

Key point 
Coordinates 

(x,y,z) 

1 (0,0) 

2 (1,0) 

4. Create Lines  

Preprocessor > Modeling > Create > Lines > Lines > In Active Coord L,1,2  

Create a line joining Keypoints 1 and 2, representing a link 1 meter long. 

5. Define the Type of Element 

Preprocessor > Element Type > Add/Edit/Delete...  

For this problem we will use the LINK33 (Thermal Mass Link 3D conduction) element. 

This element is a uniaxial element with the ability to conduct heat between its nodes. 
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6. Define Real Constants 

Preprocessor > Real Constants... > Add...  

In the 'Real Constants for LINK33' window, enter the following geometric properties:  

i. Cross-sectional area AREA: 4e-4  

This defines a beam with a cross-sectional area of 2 cm X 2 cm.  

7. Define Element Material Properties  

Preprocessor > Material Props > Material Models > Thermal > Conductivity > Isotropic  

In the window that appears, enter the following geometric properties for steel:  

i. KXX: 60.5  

8. Define Mesh Size  

Preprocessor > Meshing > Size Cntrls > ManualSize > Lines > All Lines...  

For this example we will use an element edge length of 0.1 meters. 

9. Mesh the frame  

Preprocessor > Meshing > Mesh > Lines > click 'Pick All' 

10. Write Environment  

The thermal environment (the geometry and thermal properties) is now fully described and 

can be written to memory to be used at a later time.  

Preprocessor > Physics > Environment > Write  

In the window that appears, enter the TITLE Thermal and click OK. 
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11. Clear Environment  

Preprocessor > Physics > Environment > Clear > OK  

Doing this clears all the information prescribed for the geometry, such as the element type, 

material properties, etc. It does not clear the geometry however, so it can be used in the next 

stage, which is defining the structural environment.  

Structural Environment - Define Physical Properties  

Since the geometry of the problem has already been defined in the previous steps, all that 

is required is to detail the structural variables.  

1.Switch Element Type 

Preprocessor > Element Type > Switch Elem Type  

Choose Thermal to Struc from the scoll down list.  

This will switch to the complimentary structural element automatically. In this case it is 

LINK 8. For more information on this element, see the help file. A warning saying you 

should modify the new element as necessary will pop up. In this case, only the material 

properties need to be modified as the geometry is staying the same. 

2.Define Element Material Properties  

Preprocessor > Material Props > Material Models > Structural > Linear > Elastic > Isotropic  

In the window that appears, enter the following geometric properties for steel:  

i. Young's Modulus EX: 200e9  

ii. Poisson's Ratio PRXY: 0.3  

Preprocessor > Material Props > Material Models > Structural > Thermal Expansion secant 

Coefficient > Isotropic  

i. ALPX: 12e-6  

3.Write Environment  

The structural environment is now fully described.  

Preprocessor > Physics > Environment > Write  

In the window that appears, enter the TITLE Struct 
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Solution Phase: Assigning Loads and Solving  

1. Define Analysis Type 

Solution > Analysis Type > New Analysis > Static ANTYPE,0 

2. Read in the Thermal Environment 

Solution > Physics > Environment > Read  

Choose thermal and click OK.  

 

If the Physics option is not available under Solution, click Unabridged Menu at the bottom 

of the Solution menu. This should make it visible.  

1. Apply Constraints 

Solution > Define Loads > Apply > Thermal > Temperature > On Keypoints  

Set the temperature of Keypoint 1, the left-most point, to 348 Kelvin. 

2. Solve the System 

Solution > Solve > Current LS > SOLVE 

3. Close the Solution Menu 

Main Menu > Finish It is very important to click Finish as it closes that environment and 

allows a new one to be opened without contamination. If this is not done, you will get error 

messages. 

The thermal solution has now been obtained. If you plot the steady-state temperature on 

the link, you will see it is a uniform 348 K, as expected. This information is saved in a file 

labelled Jobname.rth, were .rth is the thermal results file. Since the jobname wasn't changed 
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at the beginning of the analysis, this data can be found as file.rth. We will use these results in 

determing the structural effects.  

1. Read in the Structural Environment 

Solution > Physics > Environment > Read  

Choose struct and click OK. 

2. Apply Constraints 

Solution > Define Loads > Apply > Structural > Displacement > On Keypoints  

Fix Keypoint 1 for all DOF's and Keypoint 2 in the UX direction. 

3. Include Thermal Effects  

Solution > Define Loads > Apply > Structural > Temperature > From Therm Analy  

As shown below, enter the file name File.rth. This couples the results from the solution of 

the thermal environment to the information prescribed in the structural environment and uses 

it during the analysis. 

 

4. Define Reference Temperature  

Preprocessor > Loads > Define Loads > Settings > Reference Temp  

For this example set the reference temperature to 273 degrees Kelvin. 

 

5. Solve the System 

Solution > Solve > Current LS 
SOLVE 
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Postprocessing: Viewing the Results  

1. Hand Calculations  

Hand calculations were performed to verify the solution found using ANSYS:  

 

As shown, the stress in the link should be a uniform 180 MPa in compression. 

2. Get Stress Data  

Since the element is only a line, the stress can't be listed in the normal way. Instead, an 

element table must be created first.  

General Postproc > Element Table > Define Table > Add  

Fill in the window as shown below. [CompStr > By Sequence Num > LS > LS,1 
ETABLE,CompStress,LS,1 
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3. List the Stress Data  

General Postproc > Element Table > List Elem Table > COMPSTR > OK  

PRETAB,CompStr 

 

The following list should appear. Note the stress in each element: -0.180e9 Pa, or 180 MPa in 

compression as expected.  

 

Result: 

Thus the coupled analysis for thermal and structural is conducted using ANSYS 

software and the results are plotted. 

******************* 

 

 

 

 

 

 

 



 

 
 

 

PROGRAM OUTCOMES (POs) 
 

Mechanical Engineering Graduates will be able to 
 

1 

Engineering knowledge: Apply the knowledge of mathematics, science, 

engineering fundamentals and an engineering specialization to solution of 

complex engineering problems. 

2 

Problem analysis: Identify, formulate, review research literature, and analyze 

complex engineering problems reaching substantiated conclusions using first 

principles of mathematics, natural sciences, and engineering sciences. 

3 

Design / development of solutions: Design solutions for complex engineering 

problems and design system components or processes that meet the specified 

needs with appropriate consideration for the public health and safety, and the 

cultural, societal, and environmental considerations. 

4 

Conduct investigations of complex problems: Use research-based knowledge 

and research methods including design of experiments, analysis and 

interpretation of data, and synthesis of the information to provide valid 

conclusions. 

5 

Modern tool usage: Create, select and apply appropriate techniques, resources, 

and modern engineering and IT tools including prediction and modeling to 

complex engineering activities with an understanding of the limitations. 

6 

The engineer and society: Apply reasoning informed by the contextual 

knowledge to assess societal, health, safety, legal and cultural issues and the 

consequent responsibilities relevant to the professional engineering practice. 

7 

Environment and sustainability: Understand the impact of the professional 

engineering solutions in societal and environmental contexts, and demonstrate 

the knowledge of, and need for sustainable development. 

8 
Ethics: Apply ethical principles and commit to professional ethics and 

responsibilities and norms of the engineering practice. 

9 
Individual and team work: Function effectively as an individual, and as a 

member or leader in diverse teams, and in multidisciplinary settings. 

10 

Communication: Communicate effectively on complex engineering activities 

withthe engineering community andwith society atlarge, such as, being able to 

comprehend and write effective reports and design documentation, make 

effective presentations, and give and receive clear instructions. 

11 

Project management and finance: Demonstrate knowledge and understanding 

of the engineering and management principles and apply these to one’s own 

work, as a member and leader in a team, to manage projects in multidisciplinary 

environments. 

12 

Life-long learning: Recognize the need for, and have the preparation and ability 

to engage in independent and life-long learning in the broadest context of 

technological change. 
 [ 
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